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Introduction
The Platform Manager 2 is a fast-reacting, programmable logic based hardware management controller. Platform 
Manager 2 is an integrated solution combining analog sense and control elements with scalable programmable 
logic resources. The unique approach allows Platform Manager 2 to integrate Power Management, Thermal Man-
agement, and Control Plane functions into a single device.

This user guide describes the demo design and graphical user interface (GUI) which highlight the flexibility and 
scalability provided by Platform Manager 2. The GUI also provides an interface for accessing the various Power 
Management (Power Sequencing, Voltage Monitoring, Trimming, Margining), Thermal Management (Temperature 
Monitoring, Fan Control, Power Control) and Control Plane (Reset Control, Fault Logging) features provided by the 
Platform Manager 2 device.

GUI Overview
The GUI provides an interface to the I2C based demonstration design as well as the L-ASC10 (ASC) I2C measure-
ment and configuration features. The GUI is shown in Figure 1.

Figure 1. I2C Demo GUI

The GUI works with the Platform Manager 2 Evaluation Board as shown in Figure 2. The EVB must be programmed 
with the demo design to work with the Demonstration and Optional Demo Settings screens. The Power Manage-
ment, Thermal Management, and Control Plane Management screens can be used for debugging any design, and 
do not require that the demo design is programmed into the Platform Manager 2.
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Figure 2. Demo Design and Debug Features on Platform Manager 2 EVB
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Setup
This section describes how to connect and set up the demo.

Required Demo Components

• Platform Manager 2 Demo Design Zip File

• Platform Manager 2 Evaluation Board

• Lattice Diamond Programmer Software

• Mini USB cable to power Platform Manager 2 Evaluation Board and provide I2C connection

Project Setup
Unzip the demo design package, found in the Downloads section of the Platform Manager 2 web page.

Connect the USB cable between the PC and the evaluation board. Start Diamond Programmer to download the 
demo files. Use the Platform_Manager_2_I2C_Demo.xcf programmer configuration file to load the file into the Plat-
form Manager 2 and ASC devices.

Note: You will need to browse to locate the JEDEC and .hex files at the unzipped location as Diamond Programmer 
only stores absolute paths. See the programming procedure section of AN6091, Powering Up and Programming 
Platform Manager 2 and L-ASC10 for more details on programming the demo board.

http://www.latticesemi.com/en/Products/PowerAndClockDevices/PlatformManager2.aspx
http://www.latticesemi.com/view_document?document_id=50100
http://www.latticesemi.com/view_document?document_id=50100
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Evaluation Board Setup

• SW1 (FTDI_I2C Enable) must be pressed down. See Figure 3 for details.

• Jumpers J3, J4, J29 must be populated

• Jumper J8 must be in the +5V position

• Jumper J5 must be in the ASC1_RST (pin 1 and 2) position

• Jumper J1 must be in the USB_POWER position

• The fan included with the Platform Manager 2 Evaluation Board must be connected to fan connector J9 (Thermal 
Management demo only).

Demonstration Design
The GUI features three separate demonstrations with two optional demo settings. The demonstrations include:

• Scalable Architecture 

• Thermal Management

• Fault Logging

The optional demo settings include:

• DC/DC Clocking

• Margining

The demonstration design works with the Platform Manager 2 Evaluation Board and the demo program. (See the 
User Guide for the evaluation board in the References section for more details). The circuits on the evaluation 
board which are used in the demo program are shown in Figure 3.

The demo design is available in configuration file format only. The demo design source files are not provided due to 
incompatibility with the latest version of the design tools.
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Figure 3. Platform Manager 2 - Evaluation Board with Demo Features
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Each of the demonstrations and optional demo settings are described in the following sections.
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Scalable Architecture
The Scalable Architecture demonstration screen is shown in Figure 4. This demonstration shows the voltage moni-
toring, power and reset sequencing, and scalability provided by the Platform Manager 2 family.

Figure 4. Scalable Architecture Demonstration

There are two programmable settings in the scalable architecture demonstration:

• Number of Rails – This setting determines the number of rails sequenced in the design. The available settings 
are 1-10 Rails or 11-20 Rails. The rails are demonstrated by sequencing on the LEDs and monitoring the poten-
tiometers on the evaluation board. The 1-10 Rails setting in the demo uses the Platform Manager 2 and the 
associated potentiometers, LEDs and DC-DC4. The 11-20 Rails setting uses both the Platform Manager 2 and 
the external ASC device, along with the potentiometers, LEDs, and DC-DC4 and DC-DC8 on the evaluation 
board.

• Resets per Device – This setting determines the number of resets which are associated with each group of 5 
rails. The available settings are 1, 2, or 3. The resets are demonstrated by sequencing on the LEDs on the eval-
uation board.

The settings are stored into the device whenever the Write button is clicked. The steps and observations shown in 
the demo dynamically update if a new value for number of rails is written to the demo program.

The GUI also provides feedback by showing the voltages at the potentiometers and DC-DC converters. A green 
color code indicates that the voltage is inside of the valid window, while a red color code indicates that the voltage 
is outside the valid window. The valid windows are between 1 Volt and 2 Volts for the potentiometers, and between 
1.05 Volts and 1.35 Volts for the DC-DC converters.
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The rail and reset LEDs are shown in the board diagram in Figure 3. The scalable architecture demo also uses the 
on-board potentiometers and the manual restart button. 

The steps to run the demo, along with the expected observations, are shown in the GUI directly. These steps are 
also reproduced in Appendix A1 – Scalable Architecture – Steps and Observations (Setting = 11-20 Rails) and 
Appendix A2 – Scalable Architecture – Steps and Observations (Setting = 11-20 Rails).

Thermal Management
The Thermal Management demonstration screen is shown in Figure 5. This demonstration shows the temperature 
monitoring, fan control, and power control provided by the Platform Manager 2 family.

Figure 5. Thermal Management - Demonstration

There are several programmable settings in the Thermal Management demonstration:

• Temperature Thresholds (Warm and Hot) – These settings determine the warm and hot temperature thresh-
olds at the heated demo resistor. These settings are automatically populated when the thermal management 
demo is opened, based on a pre-defined offset from the measured board temperature. Warm is preset to Board 
Temp + 2°C, while Hot is preset to Board Temp + 4°C. These settings can be updated using the drop-down menu 
and the Write button.

• On Fault Set Fan Speed (Warm and Hot) – These settings determine the fan speeds applied by the demo 
design when the temperature is above the warm or hot threshold. The GUI supports PWM duty cycle speed set-
tings of OFF, 25%, 50%, 75%, and FULL. The default settings are Warm – 50%, Hot – FULL. 

• Wait After Changing Fan Speed – This setting determines the wait time used by the demo program before 
moving to the action defined in the If Fault Persists Respond With setting. The wait time can be set to either 3 
seconds or 5 seconds (default setting). See Figure 6 and Figure 7 for more details on how the wait time works 
with the fault states.
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• If Fault Persists Respond With (Warm and Hot) – These settings determine the demo program response 
when the warm or hot temperature alarms persist for longer than the Wait After Changing Fan Speed setting. 
The available warm settings are Supply Voltage – 5%, and Supply Voltage – 10%. The available hot settings are 
Supply Voltage -10% and Full Shutdown. The default settings are Warm = Supply Voltage – 5%, and Hot = Full 
Shutdown. Figure 6 and Figure 7 show the flow chart through the various fault states in the demo.

The settings are stored into the device whenever the Write button is clicked. The demo settings are populated 
automatically when the GUI opens, and can be refreshed by clicking the Read button. The Start button is used to 
begin the demo.

The GUI also provides feedback by showing the board temperature, and the temperature measured at the heater 
resistor. The Demo Resistor* Temp value is color coded to indicate the alarm state. A green color code indicates 
that the heater resistor temperature is below the warm threshold. An orange color code indicates that the tempera-
ture is above the warm threshold but below the hot threshold. A red color code indicates that the temperature is 
above the hot threshold. The GUI also shows the voltage at DC-DC4. This is the DC-DC converter used to demon-
strate the power control updates of the supply voltage by the demo.

The demo works with the Fan 2 connector and heater resistor as shown in the board diagram in Figure 3. The 
demo also uses the LCD screen to communicate the status of the heater resistor.

The steps to run the demo, along with the expected observations, are shown in the GUI directly. These steps are 
also reproduced in Appendix B – Thermal Management – Steps and Observations demonstration steps and obser-
vation. A flow chart of the demo logic is shown below in Figure 6 and Figure 7.
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Figure 6. Thermal Management Demo - Flow Chart P. 1
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Figure 7. Thermal Management Demo - Flow Chart P. 2
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Fault Logging
The Fault Logging demonstration screen is shown in Figure 8. This demo shows the fault logging and readback 
functionality of the ASC.

Figure 8. Fault Logging - Demonstration

The demo automatically enables the fault logging when this screen is open. The steps/observations included in the 
GUI provide a step by step process to generate, store and readback faults using the evaluation board. These steps 
are also reproduced in Appendix C – Fault Logging – Steps and Observations.

The Read Fault Log Mem button opens the fault readback dialog screen. This screen is described in more detail in 
the Read Fault Log Mem section.
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DC/DC Clocking (Optional Demo Setting)
The DC/DC Clocking option screen is shown in Figure 9. This screen is used to modify the behavior of the demo 
program Sync signals. These signals are used to determine the phase relationship between the switching DC-DC 
converters on the evaluation board.

Figure 9. DC/DC Clocking - Optional Demo Setting

There are two settings for this option: Synchronous (Default) or 90 degree Phase shifts. The Sync signal behavior 
can be observed at the Sync test points shown in the evaluation board diagram (see Figure 3). Click the Write but-
ton to store the modified setting to the demo program. The behavior of the sync signals with the Synchronous set-
ting is shown in Figure 10, with the 90 degree Phase shifts setting shown in Figure 11.

Figure 10. DC/DC Sync Signals - Synchronous Setting
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Figure 11. DC-DC Sync Signals - 90 Degree Phase Shift Setting
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Margining (Optional Demo Setting)
The Margining option screen is shown in Figure 12. This screen is used to modify the output voltage of the DC-DC 
converters on the evaluation board. All converters which are populated and enabled respond to the settings in this 
screen with their output voltage being margined up (+5%) or down (-5%). Click the Write button to store the modi-
fied setting to the demo program.

Figure 12. Margining - Optional Demo Setting
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Power Management
The GUI provides a set of views for accessing the I2C features of the ASC associated with power management. 
Access to these settings does not require the demo design be programmed into the Platform Manager 2. These I2C 
access views can be used to debug custom designs on the Platform Manager 2.

Voltage Monitor (VMON)
The voltage monitor screen is shown in Figure 13. The voltage monitor screen shows the device settings and volt-
age status for each voltage monitor in each ASC present on the board. Each ASC is given a different tab in the 
view, accessed at the top of the VMON screen.

Figure 13. VMON - Power Management

The device settings include the threshold settings for comparator A and B, and the glitch filter and window mode 
setting per VMON. The available thresholds depend on the detection setting chosen for each VMON comparator. 
The GUI provides the capability to update these settings, and store them using the Write button. 

The VMON screen also displays the voltage measured at the VMON channel, as well as the status of comparator A 
and B for each VMON.

The VMON screen automatically populates the settings and measurements whenever the screen is opened. The 
settings and measurements can also be updated by clicking the Read button. (Note that the detection setting for 
each comparator needs to be set by the user. This is set by the application, and not stored in the device. See the 
References section for more details).
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Current Monitor (IMON)
The current monitor screen is shown in Figure 14. The current monitor screen shows the device settings and status 
for each current monitor in each ASC present in the design. Each ASC is given a different tab in the view, accessed 
at the top of the IMON screen.

Figure 14. IMON - Power Management

The device settings include the trip points for comparator A and B, and the glitch filter and window mode setting per 
IMON. The available trip points depend on the sense resistor setting chosen for each IMON. The GUI provides the 
capability to update these settings, and store them using the Write button.

The IMON screen also displays the current measured at the IMON channel (dependent on the sense resistor set-
ting), as well as the status of comparator A and B for each IMON.

The IMON screen automatically populates with the active settings and measurements whenever the screen is 
opened. The settings and measurements can also be updated by clicking the Read button. (Note that the sense 
resistor setting for each IMON needs to be set by the user. This is set by the application circuit, and not stored in 
the device. See the References section for more details).
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Trim Cells
The Trim Cells screen is shown in Figure 15, with the Trim Cell1 dialog open. The Trim Cell screen provides sepa-
rate tabs for each ASC in the system, with each of the four trim cells per ASC accessed by their own Trim Cell but-
ton.

Figure 15. Trim Cells - Power Management

The individual Trim Cell dialog shows the voltage measured at the associated voltage monitor (VMON1 for Trim 
Cell1, VMON4 for Trim Cell4, and so forth). This Output Voltage reading is updated when the dialog is first opened, 
and whenever the Read button is clicked. The Target Value is also shown. This is the value stored as the Profile 0 
Trim Setpoint. The value is automatically populated when the dialog is opened. The value can be updated in the 
device by clicking the Write button.

The updated target value affects the “Normal” setting in the Margining demo window (see the Margining (Optional 
Demo Setting) section for more details). The +5% and -5% settings are not affected by the updated target value.
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GPIO
The GPIO window is shown in Figure 16. This window displays the status of each pin, as well as the input/output 
setting per pin. The window provides a separate tab for each ASC in the system.

Figure 16. GPIO - Power Management

GPIO2 and GPIO3 can also be controlled by the I2C interface, or other ASC hardware. This control setting can be 
updated using the drop-down menu next to the output radio button for both GPIO2 and GPIO3. If I2C is selected as 
the control setting, then the pin status can be directly controlled for the given I/O. As with other menus, Write is 
used to store the update settings to the device, while Read is used to refresh the displayed settings and pin status.
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High-Voltage Outputs (HVOUT)
The HVOUT window is shown in Figure 17. This window displays the status of each pin, as well as the output 
source and mode settings per pin. The window provides a separate tab for each ASC in the system.

Figure 17. HVOUT - Power Management

The window allows you to change the control source of an HVOUT, configure the HVOUT as Switched mode with 
frequency and duty cycle settings, and configure the charge pump voltage and current settings.

HVOUTs which are configured with the OCB control source, and I2C Output Source Signal, can be controlled 
directly by the GUI (by clicking the status below each HVOUT label). As with other menus, Write is used to store 
the update settings to the device, while Read is used to refresh the displayed settings and pin status.
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Thermal Management
Temperature Monitors (TMON)
The temperature monitor screen is shown in Figure 18. The temperature monitor screen shows the measured tem-
perature, comparator status and threshold settings for each temperature monitor in each ASC present in the 
design. Each ASC is given a different tab in the view, accessed at the top of the TMON screen.

Figure 18. TMON - Thermal Management

The TMON screen is populated with the measured temperature, comparator status, and temperature thresholds 
automatically after it is opened. TMON1 and TMON2 must be enabled in the design file programmed into the ASC 
devices. TMONs which are not enabled in the design always read -64.00° C. The threshold settings can be 
updated using the drop down menus.

Write is used to store the updated settings to the device, while Read is used to refresh the displayed temperature 
measurement, comparator status, and thresholds.
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Control Plane Management
Read Fault Log Mem
The Read Fault Log Mem screen is shown in Figure 19. The Read Fault Log Mem screen is used to access the 
ASC fault log EEPROM (the V,I,T fault log). The Read Fault Log Mem screen displays the total number of faults and 
the fault status of each monitor and I/O signal for a given fault record. Each ASC in the design has its own tab with 
individual fault information.

Figure 19. Read Fault Log Mem - Control Plane Management

The Fault Log Record automatically populates with the record information from the first fault log when the window is 
opened. It also populates the total number of faults. There are several buttons available in the fault log window to 
read and erase fault records. These include:

• Read Total – This button polls each ASC in the system and refreshes the total number of faults displayed.
• Read Previous – This button can be used to read the previous record in the fault memory. If Fault Record #3 is 

shown in the view and this button is clicked, then Fault Record #2 will be shown in the view. This button is only 
active if a lower numbered fault record is available.

• Read Next – This button can be used to read the next record in the fault memory. If Fault Record #2 is shown in 
the view and this button is clicked, then Fault Record #3 will be shown in the view. This button is only active if a 
higher numbered fault record is available.

• Read Last – This button shows the last available record in the view. If there are 10 records in the fault memory 
and this button is clicked, then Fault Record #10 will be shown in the view.

• Erase All – This button erases the fault record memory of all ASC devices in the system. The fault memory can 
only be erased all at once, individual records or ASCs cannot be erased.
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Additional Debug Functions
UES (User Electronic Signature)
The UES button opens the view shown in Figure 20. The GUI reads out the UES value stored inside the Platform 
Manager 2 ASC section automatically when this view is opened. The display settings can be changed using the 
radio buttons between Binary, Decimal, and HEX. This view only supports reading out the UES of the device, as 
this setting is stored in the device EEPROM. See the References section for more details.

Figure 20. UES (User Electronic Signature)

All I2C
The All I2C button opens the view shown in Figure 21. The GUI automatically reads out all the Measurement and 
Control and Configuration registers from the ASCs in the system when the view is opened. The GUI displays the 
bit-by-bit values of each of the registers, rather than the actual settings (such as thresholds, etc). Most of the regis-
ters in this view can also be updated using the individual feature views (such as VMON or TMON).

Figure 21. All I2C Registers

You can read or write individual I2C registers from this view. Double-clicking an address opens an editing dialog for 
that particular register. You can edit several registers and then click the Write button to update the device settings. 
You can write or read individual registers or all registers at once. After writing a value to a register, you must click 
the Update Configuration button to load the register updates to the working device configuration. The Hide and 
Show buttons allow you to update the displayed register set. Each ASC is shown in a separate tab. See the Refer-
ences section for more details on the register map and the measurement and configuration features of the ASCs.



22

Platform Manager 2 I2C Demo Design and GUI 

Options Menu
The Options Menu consists of four choices, as shown in Figure 22.

• Large GUI – Changes the font size and display size used in the GUI. The default setting is Large GUI.

• I2C Interface – Opens a view for selecting I2C Cable Interface and I2C Baud Rate
– I2C Cable Interface – The cable interface can be set to either USB2 FTDI Interface (default setting) or 

Demo Mode (Bypass Interface Checks). The USB2 FTDI setting works with the Platform Manager 2 Evalua-
tion Board. The Demo Mode allows you to view the Demo and Debug screens with no board connected.

– I2C Baud Rate Configuration – The baud rate may be set to either 100 kHz or 400 kHz (default).

• I2C Address – Opens a view for setting both the ASC Section (4 MSB) and FPGA Section I2C addresses
– ASC Section (4 MSB) – The ASC Section (4 MSB) should be set to match the address used by the ASC 

devices on the evaluation board. The default setting – 1100XXX – matches the setting used in the demo 
design. The GUI builds the ASC0-ASC7 addresses from this MSB setting.

– FPGA Section – This setting is not used in the current version of the GUI.

• Data Logging – The data logging is discussed in more detail in the next section.

Figure 22. Options Menu
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Data Logging
The Data Logging view opened from the Options menu is shown in Figure 23. This view is used to select the items 
which will be recorded in the log file. The view includes a separate tab for each of the ASC devices in the system. 
Each VMON, IMON, TMON, HVOUT, and GPIO pin can be individually enabled or disabled in this view. The Select 
All button will select all the monitor and I/O signals for the given ASC. The Clear All button will unselect all the sig-
nals for the given ASC.

Figure 23. Options - Data Logging Screen

 

Once the Data Logging options have been selected, the data logging can be started in the File > Start Data Log-
ging view. This view is shown in Figure 24. The settings available in the Start Data Logging view are:

• Delay – The Delay is the time between samples of the selected values in the Data Logging Options screen. The 
Delay can be set in seconds, from 1 (Default) to 180.

• Total Records – The Total Records is the number of records the log file will store before completing logging. The 
Records can be set between 0 (Default) and 1000. Choosing the 0 setting will set the number of records to unlim-
ited. The data logging will run until the stop button is pressed when 0 is selected for number of total records.

• Browse – This button sets the log file name and storage location. Clicking the browse button will open the Save 
As file dialog. The Default value is LPTM2 I2C Demo.log. 

• Start – This button will begin the logging process. The logging process will continue until the total # of records is 
logged, or the Stop button is pressed.

• Stop – This button will stop the logging process immediately. 
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Figure 24. File - Start Data Logging Screen

 

The data log will store the measurements values of the selected monitor signals and the status of the GPIO and 
HVOUT signals selected. The log file begins with header information about the Utility Version, Driver Settings, Log-
ging Interval, and Time Stamp.

Figure 25 shows an example data log opened in a text editor program. In this data log, the following signals are 
logged:

• ASC0 – VMON7 and TMON2

• ASC1 – VMON5, HVOUT2, GPIO2, TMON3, and IMON2

The log file can also be treated as a comma-separated value file in a spreadsheet viewer.

Figure 25. Example Log File in Text Editor
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Summary
The Demo Design and GUI highlight the flexibility and scalability provided by Platform Manager 2. This user guide 
explains the features of the GUI and the behavior of the Demo Design. Further information about the device and 
the evaluation board can be found in the References section.

Known Issues
• The thresholds shown in the Voltage Monitor and Current Monitor views do not match the settings shown in the 

datasheet. The datasheet settings reflect the actual device settings. The settings shown in the GUI are within 1% 
of the actual device settings.

• In the ALL I2C view, the Update Configuration button does not function properly. This means that values 
updated using the Write buttons in the ALL I2C view will not be copied to the current configuration of the device.

References
• DS1042, L-ASC10 Data Sheet

• DS1043, Platform Manager 2 Family Data Sheet

• EB93, Platform Manager 2 Evaluation Board User Guide

• AN6091, Powering Up and Programming Platform Manager 2 and L-ASC10
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Appendix A1 – Scalable Architecture – Steps and Observations 
(Setting = 11-20 Rails)
Steps
1. Start Demonstration: Sequence & Resets Controlled by Platform Manager 2.

2. Move potentiometers (POT1 – R33 and POT2 – R35) to the middle position.

3. Press Manual Restart button and wait for all 10 supply LEDs to turn on. 

4. Create fault by moving POT1 or POT2 or pressing PB_SW3.

5. Change Settings from 1-10 Rails to 11-20 Rails or change number of Resets per Device. Click Write and press 
Manual Restart to demonstrate Scalable Architecture.

6. Click Done to exit Scalable Architecture demonstration.

Observation
1. All supply and reset LEDs are off.

2. POT1 and POT2 turn green in the Power Network Window.

3. 1, 2, or 3 Reset LEDs turn on after 5 supply LEDs sequence on. DC-DC4 supply is also turned on. This dem-
onstrates supply and reset sequencing without using power-good signals.

4. Power supply shut down depends on the fault. Reset LEDs turn off with relevant supplies.

5. Changing setting from 1-10 rails to 11-20 rails demonstrates supply sequencing expansion using external L-
ASC10 (Centrally controlled by FPGA in Platform Manager 2). 
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Appendix A2 – Scalable Architecture – Steps and Observations 
(Setting = 11-20 Rails)
Steps
1. Start Demonstration: Sequence & Resets Controlled by Platform Manager 2 and L-ASC-10.

2. Move potentiometers (POT1 – R33, POT2 – R35, POT3 –R38 & POT4 –R40) to the middle position.

3. Press Manual Restart button and wait for all 20 supply LEDs to turn on.

4. Create fault by moving POT1, POT2, POT3 or POT4 or pressing PB_SW3.

5. Change setting from 11-20 Rails to 1-10 Rails or change number of number of Resets per Device. Click Write 
and press Manual Restart to demonstrate Scalable Architecture.

6. Click Done to exit Scalable Architecture Demonstration.

Observation
1. All supply and resets LEDs are off.

2. POT1, POT2, POT3 and POT4 turn green in the Power Network Window.

3. 1,2, or 3 reset LEDs turn on when 5 supply LEDs sequence on. DC-DC 4 & DC-DC 8 supplies are also turned 
on. This demonstrates supply and reset sequencing without using power-good signals.

4. Power supply shut down depends on the fault. Reset LEDs turn off with relevant supply LEDs.

5. Changing setting from 1-10 rails to 11-20 rails demonstrates supply sequencing using only the Platform Man-
ager 2.
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Appendix B – Thermal Management – Steps and Observations
Steps
1. Start Demonstration: Thermal Management Through Fan Speed and Power Dissipation Control by click-

ing Start.

2. Move the Fan close to the board with airflow directed at resistor (R203).

3. Press Manual Restart button and observe Thermal Management responses.

4. After observation, press Manual Restart, move the Fan close to the board with airflow directed at resistor 
(R203). 

5. After resistor temp reading turns green, update different Thermal Management Config settings or change fan 
position, then click Write and restart the demonstration from step 3.

6. Click Done to exit Thermal Management Demonstration.

Observation
1. The fan turns on and LCD displays resistor heater state of OFF. 

2. The Demo Resistor Temp is displayed in green, indicating the temperature is below the warm limit

3. The resistor heater is turned on (LCD displays On) and its temperature is shown by the temp reading and color. 
When the resistor gets warm, the fan is turned on to cool the resistor. The Demo Resistor Temp is displayed in 
orange, indicating the temperature is above the warm limit. Observe one of the following conditions:

A. Temp drops below Warm Threshold, Fan turns off and the resistor starts to heat up. This warming and cool-
ing cycle repeats.

B. If temp remains warm after 3/5 seconds, the DC-DC4 Voltage will reduce - reducing power dissipation.

C. If temp crosses Hot Threshold, Fan speed increases, and the Demo Resistor Temp is displayed in red.

D. If temp remains hot after 3/5 seconds, full shut down occurs – Protecting the IC from thermal run away (All 
power LEDs are off).

4. When Manual Restart is pressed, the heater is turned off (LCD displays OFF) and fan turns on full speed. The 
fan cools down the resistor (R203).

5. By changing the Thermal Management Configuration or air flow to resistor, it is possible to observe the algo-
rithm executing steps A to D. Flexible Thermal Management (Temp Measure, Fan Speed Control, Power Dissi-
pation Control) is entirely controlled by the algorithm in the FPGA.
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Appendix C – Fault Logging – Steps and Observations
Steps
1. Start Demonstration: Non Volatile Fault Capture in Platform Manager 2 & L-ASC10. 

2. Move Potentiometers (POT1 – R33, POT2 – R35, POT3 –R38 & POT4 –R40) to the middle position.

3. Press Manual Restart button and wait for all supply LEDs to turn on.

4. Create fault by moving POT1, POT2, POT3 or POT4 or pressing PB_SW3.

5. Click Read Fault Log Mem.

6. Repeat from step 2 with other faults. 

7. Click Done to exit Fault Logging Demonstration.

Observation
1. All supply and reset LEDs are off.

2. POT1, POT2, POT3 & POT4 Boxes in the Power Network Window turn green.

3. 1, 2, or 3 reset LEDs turn on when 5 supply LEDs sequence on. DC-D.C 4 & DC-DC 8 supplies are also turned 
on. This shows board is operating normally.

4. Power supply shut down depends on the fault. Reset LEDs turn off with relevant supply LEDs. Fault is logged in 
parallel with shut down.

5. The fault log shows the primary cause of the fault captured by either the Platform Manager 2 or L-ASC10.
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